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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive; recipients details are not shared with, or available to, anybody except me.  
Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

August 2017  
•2——Mac News ~ New Intel 

18-core CPUs, marks and awards, 
games, Cook and Charlottesville 
•4——Updates ~ The Beta beat 

and ARKit 
•6——Mac Help ~  

Around New Zealand 
•7—— iOS & iDevice news ~ 

Lawsuit, Star Wars, new security, 
AirPods, storage, iTunes U, Beijing 

transport, secure mail app 
•9——Apple & Talk ~ iPhone ‘ate’, 

and augmenting our reality 
•11——Tips & Tricks ~ Memories 

in Photos, screenshots, camera 
data, Preview, Apple Watch, 

iMazing, Boolean Spotlight  
and other macOS tips, changing 

WiFi passwords for AirPort 
•18——Shiny & New ~ Norton 

WiFi privacy, Moshi symbus  
Compact Dock 

Zoom UAC-2 audio interface.

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

It’s almost spring here, and totally a new iPhone is imminent – at this point, it looks like Apple will announced ‘iPhone 8 ‘on 
September 12th – you can always look for slightly reduced prices on the excellent iPhone 7 if the ‘8’ proves too expensive  

(image from Apple’s iPhone 7 page)
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http://www.creativetech.net.nz
http://www.mac-nz.com
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Mac News > Late 2017 Mac Pro CPUs? Apple gets a B+, but also nets AI award

18-core Intel Xeon W processors
Intel has revealed its new collection of 
Xeon processors aimed at workstations, 
with the Xeon W range boasting 48 PCIe 
3.0 lanes and up to 18 cores on a single 
chip, making the new processor line prime 
candidates for use in the upcoming iMac 
Pro due in December.

Apple gets a B+
RESCUECOM has released its 2017 back-

More news is online at Mac NZ

to-school Computer Reliability Report, 
which compares the brand market share 
of computer makers with their repair 
share, based on the number of computer 
repair calls received per brand, to create 
an overall reliability score. The report 
includes desktops, laptops and tablets.
The Reliability Report only gave Apple 
B+ as a reliability grade. Two companies 
received “A+” grades: Amazon (which 
makes the Fire tablet) and RCA (which 

makes budget tablets and smartphones).
However, Apple came out ahead of 
Samsung (B) and all companies that also 
make desktops and laptops. IBM/Lenovo 
received a C-, Dell a D+, Microsoft and 
Acer a D-, Asus an F, and HP, an F.

AI research paper wins award
Apple’s first public academic paper won a 
Best at the 2017 Conference on Computer 
Vision & Pattern Recognition.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://appleinsider.com/articles/17/08/29/new-18-core-intel-xeon-w-processors-likely-to-be-used-in-apples-imac-pro
http://appleinsider.com/articles/17/08/29/new-18-core-intel-xeon-w-processors-likely-to-be-used-in-apples-imac-pro
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http://appleinsider.com/articles/17/08/25/apples-first-ai-research-paper-wins-prestigious-machine-learning-award


>>

>
>

Mac NZ

page

3
MagBytes

#90

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

Mac News > More Mac games, Cook on fighting hate

More news is online at Mac NZ

Intel details 8th-generation Core i7, 
i5 processors suitable for MacBook, 
dual-core MacBook Pro refresh — Intel 
launched its 8th-generation processors on 
Monday, starting with the with the new 
‘U-series’ chips for notebooks boasting a 
40% performance boost compared to the 
previous generation, though while this 
series is suitable for use in MacBooks and 
the dual-core MacBook Pro, it won’t help 
provide users with a 32GB memory option.

Sudden Strike 4
Kalypso Media has released Sudden 
Strike 4, a World War II strategy title for 
macOS. It sends you off on three extensive 
campaigns set amongst the battlefields 
of the second World War. You’re tasked 
to prove your tactical expertise in 
over 20 single player scenarios, the 
challenge-focused skirmish mode, and the 
competitive multiplayer mode. A reward 

system awards the player for clever play 
with skill points and bonus unlockable 
content. Here’s a teaser trailer.
Sudden Strike 4 is available now worldwide 
for Mac on the Mac App Store. It requires 
macOS 10.6.6 or higher and costs 
NZ$66.99/US$44.95.

Formula One 2017 for Mac
Feral Interactive has announced that 
Formula One 2017 will be released on 
August 25th, with a same-day release for 
Mac and PC. 
The game, created by Codemasters, offers 
a stunning Formula One racing experience. 
In addition to the trailer, Codemasters 
released a 26 minute, unedited gameplay 
video that is just unbelievable. The game 
features a Research 7 Development tree, 
the ability to tune the cars, a career mode, 
and off-track activities. 
The game will be available through Feral 
and Steam for US$59.95, with a Mac App 
Store version coming later for US$49.99. 
System requirements haven’t published, 
but are likely to be steep. If you’re a racing 
game enthusiast, it’ll be worth it.

Beat The Game for Mac
Worm Animation says its debut title, 
point-and-click music adventure Beat the 
Game, will launch September 7 on Steam 

for Mac, PC, and Linux systems. In the 
game, players go on a journey with Mistik, 
the hero of Beat The Game, to uncover 
the mysterious, abstract universe he finds 
himself in after a motorbike crash. Mistik, 
though, is a music producer. 
With the help of his trusty recorder, Mistik 
must collect the samples scattered around 
Beat The Game’s beautiful, dream-like 
environments in order to create the 
ultimate track.

Macs & Bioshock Remastered
The Remastered version of BioShock will 
bring the Art Deco first person shooter to 
1080p.
But you’re going to need a Mac from 2013 
or later to run it.

Tim Cook and Charlottesville
Responding to the demonstrations in 
Charlottesville, Virginia which resulted 
in the death of a human rights protester, 
Apple CEO Tim Cook sent a letter to 
company staff deriding hate groups, 
bigotry and violence, and denouncing 
President Donald Trump’s speech claiming 
‘equivalence’ of white nationalists and 
human rights advocates. 
Apple has also cut of Apple Pay support to 
any companies promoting hatred, and for 
websites selling white supremacist goods.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.mac-nz.com
https://www.appleworld.today/blog/2017/8/21/sudden-strike-4-game-blasts-onto-the-mac
https://www.appleworld.today/blog/2017/8/21/sudden-strike-4-game-blasts-onto-the-mac
https://www.youtube.com/watch?v=NF8Q3VvfZD4
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https://www.macobserver.com/cool-stuff-found/formula-one-2017-mac-day-release-windows-august-25th/
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iOS 11 Public Beta 5
Apple has released iOS 11 Public Beta 5. Mac Observer noted 
earlier that Apple released developer betas just one week after 
the last developer betas. 
That, plus a same-day release of a new public beta shows that 
Apple is speeding up its release cycle. Apple released iOS 11 Public 
Beta 4 the Tuesday before (six days).

Video of  changes in newest iOS 11 Betas
Cult of Mac and YouTube channel EverythingApplePro have 
released videos highlighting the changes between iOS 11 beta 4 
and 5. I thought I was quick to update. These guys must have been 
up all night comparing the two versions of the beta software. 
Let’s take a look at what they uncovered in iOS 11 Beta 5.

iOS 11’s alternate Control Center, app switcher
A pair of tutorial videos found in Apple’s latest iOS 11 beta release 
depict what appears to be an alternate Control Center interface 
and app switcher swipe gestures never before previewed.

Apple’s Screen Recording feature in iOS 11 
One potentially useful feature coming to this next iOS 11 is a 
native Screen Recording option on the iPhone and iPad. Here’s 
how you will be able to make use of it, including embedding 
results into a video.

iOS 11 to get extra AirPods controls 
Apple’s AirPods are currently limited to a trio of controls on 
both earpieces, but their functionality will be greatly enhanced 
this southern spring (northern autumn) with the release of iOS 
11, giving users the ability to give each wireless pod a separate, 

Updates > Beta beat; screen recording, AirPods control, Portrait Mode, ARKit’s rise

customisable function with a double tap. 

Apple’s Portrait Mode in iPhone 7 Plus exits beta
In iOS 11 beta, Apple has taken the Portrait Mode camera setting 
out of beta, and has altered how the camera roll handles the 
pictures to allow for the effect to be removed from a picture 
using it at any time.

Unreal Engine updated ARKit support in iOS 11
The new version of Epic’s Unreal Engine provides basic ARKit 
support for iOS, developed in collaboration with Peter Jackson’s 
Wingnut AR.
The updated version of Unreal Engine, version 4.17, also has 
improvements in virtual reality creation and presentation; the 
update includes an “early, experimental” implementation of 
Apple’s ARKit.

iOS 11 ARKit demos plated food, 3D sculpting
Two new ARKit demonstrations by developers are showing the 
rapid advancement of what is possible with the new technology, 
with one showing food on a plate prior to ordering, and the 
other illustrating 
sculpting and 
painting with 
the iPad for 
use in other AR 
applications. 
ARKit’s resources 
were updated by 
Apple recently.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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USB-C to USB Cable
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

IonGlass for 
iPhone 7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

USB-C to VGA adapter
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees 
a hassle-free setup for convenient home or office 
use
NZ RRP$69.99

USB-C Charge Cable
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with a USB-C 
MacBook. At 2 metres length (6.6 feet) in length, a 
HandyStrap is also included to keep your cable tidy 
during transport. NZ RRP$59.99

armour for  
iPhone 6-7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

Symbus Compact USB-C Dock
Moshi’s Symbus is a compact USB-C dock that turns your 
laptop into a desktop system with one cable. Symbus 
connects your MacBook or USB-C laptop to an HDMI 
monitor, wired internet and 2 USB peripherals such as a 
keyboard, mouse or external storage. The dock supports  
4K video outputs and digital surround sound to HDMI-
equipped displays, AV receivers, or projectors and can 
charge the MacBook and 13-inch MacBook Pro. 
NZ RRP $269.99 (US$124.95)

mailto:mac.nz%40me.com?subject=From%20MagBytes
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top), but the first 
thing you can do is open the Utilities folder 
on your Mac’s applications folder, and find 
Apple’s Disk Utility (that’s its icon, above). 
Launch it, select your Mac’s internal hard 
drive which is normally called ‘Mac HD’ 
(or choose any plugged in hard drive/flash 
drive/camera card etc) and run First Aid 
over it. (iDevices are another story!)

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
Contact MacNorth Computers 09 433 
9855, 027 490 2332, or email Dave 
Boswell.

Mac Help > Apple diagnostics, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news

Logitech ad

Court throws out lawsuit
A Californian judge has thrown 
out the suit brought against Apple 
by the father of a college student 
killed in a road accident by a texting 
driver, one where it was claimed 
Apple had failed to incorporate 
technology into the iPhone that 
would prevent it from working 
while the user is driving. [Because 
if you text on a phone while driving, 
you’re a bloody idiot, and it’s not the 
manufacturers’ fault. I still see this 
all the time, even a few nights back 
with the woman driving behind me to 
Auckland Airport.]

Star Wars promotion
Disney is going to promote 
upcoming movie Star Wars: The 
Last Jedi using augmented reality 
(AR) on iPhones and iPads, with 
a promotion that requires users 
to scan codes to unlock AR 
experiences with characters from 
the film using the Star Wars iOS 
app.

New security in iOS 11
The latest beta release of iOS 11 
includes a new security feature, 
with a few button presses making 

> Lawsuit, Star Wars promo AR in app, new security features

More news is online at Mac NZ
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iDevice news> AirPods, iPhone storage, iTunes U, Beijing trains, secure mail 

it impossible to unlock your phone with 
Touch ID, as well as giving a quick option 
to dial 911. Here’s how to use it.  
iOS 11 will also introduce a new Smart 
Invert viewing mode, which you can see in 
this video.  
It intelligently inverts all screen colours 
except for those in displayed media, such 
as photos, videos, and icons. 
The feature might be used to extend 
battery life on an upcoming OLED-
equipped ‘iPhone 8.’

AirPods ship times drop
AirPods ship times from Apple’s online 
store have dropped below one month 
for the first time since the popular 
headphones debuted more than eight 
months ago, though third-party resellers 
have stock available for immediate 
purchase. AirPods cost NZ$159.

Making the most of  your iPhone 
storage space
Apple offers a couple of great ways to 
make the most of your iPad or iPhone 
storage space.

iTunes U to Podcasts app
Apple is preparing to migrate iTunes U 
Collections from the iTunes U app to Apple 
Podcasts, with a warning to educational 

institutions advising the change will take 
place in September as part of the release 
of iTunes 12.7.

Beijing transport nixes Apple
Apple continues to face difficulties in 
China, as the company’s iPhone just got 
shut out of mobile payments for Beijing’s 
public transportation system.  
Yikatong, the payment 
card operator for that 
system, just launched 
an Android-only app for 
paying for fares and no 
plans for an iPhone app 
have been announced.

More Smart 
Connector 
coming
A recent conversation 
with manufacturers 
mostly points the 
finger at Apple for 
slow rollout of Smart 
Connector peripherals, 
but Apple itself says 
that vendors have 
products in the pipeline 
using the technology.
Apple’s Smart 
Connector debuted 

More news is online at Mac NZ

with the iPad Pro in the fall of 2015. At 
present, the connector is seen on the 
entire iPad Pro line, including the new 
10.5-inch iPad Pro. It has yet to debut on 
the iPhone, despite being rumoured for 
inclusion in the iPhone 7.
The only peripherals for it at present are 
made by Apple itself, or Logitech.

Kiwi-founded app 
secures email 
A Kiwi-founded secure 
messaging app for iOS 
(and Android) has added 
a new feature that allows 
you to delete messages, 
files, photos and videos 
you’ve accidentally sent on 
your device, the recipient’s 
device, or both even after 
you’ve sent it. 
The app, SafeSwiss, is free 
to download and also 
boasts stronger-than-
military-grade end-to-end 
encryption using elliptical 
curve cryptography, 
Snapchat-style timed 
delete, and has all its 
servers in Switzerland to 
bypass local encryption 
backdoor laws.
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apple&talk > iPhone ate ... How does it stack up? We have no real idea yet. 

Looks like September 12th will be the 
date Apple launches its ‘completely 
new’ iPhone. That means it won’t be new 
tech in an existing case, but an all-new case 
as well.  
But that’s not an official, Apple-announced 
date, either, it’s just the ‘widely tipped’ 
date. Apple may also usher in this new 
device in its new campus, Apple Park, the 
huge round facility it’s been building over 
the last couple of years in Cupertino.
As I’ve mentioned before, papers all over 
the world, including to its discredit the 
New Zealand Herald, have been publishing 
articles as if the iPhone 8 already exists and 
they already know what’s in it. Neither have 
been even remotely true. Along with lists 
of its guessed-at ‘features’ have been the 
usual naysayers predicting its failure. These 
commentators have been doing this for 
decades now, before every imminent Apple 
launch.
Clearly they haven’t been learning from 
their own failures. Perhaps I’m being harsh 
on the Herald, which is essentially just a 
republisher these days anyway, with almost 
no journalists to draw on – how’s that 
working out for you? Anyway, some even 
otherwise reputable Apple commentary 
sites have been indulging in this stupidity, 
and presumably for the same reason: for 
web traffic and readership.

Meanwhile, 
Samsung has 
launched its 
Galaxy 8. 
Samsung has 
made some 
pretty hot phones 
for sure, and 
indeed its hereditary CEO has been in hot 
water himself and is now facing jail time. 
The Note 8 has a large ‘Infinity Display’ 
(edge-to-edge) along with Samsung’s 
first dual camera module [which Apple 
introduced with iPhone 7+), an improved S 
Pen, and features like iris scanning, facial 
recognition, and wireless charging. The 
Galaxy 8 uses a Snapdragon 835 CPU, 
currently the most powerful chip available 
to Android devices. 
It’s produced using 10-nanometer 
manufacturing, which means its tiny 
transistors are placed ever so slightly closer 
together. iPhone 7 uses 14-nanometre; 
iPhone 8 will most likely have 
10-nanometer. But despite fewer cores and 
slower clock speeds, iPhones have been 
outpacing its fastest Android-powered 
rivals in benchmarks and speed tests for 
years thanks to Apple being able to refine 
and integrate every single component in its 
devices. Actually, when you think about it, 
Samsung should be able to do this too … 

Anyway, if you can handle the Android 
flurry of overlapping operating systems 
available, it looks like an advanced and 
excellent smartphone, although its getting 
towards tablet-size.

Where will Apple go with iPhone 8? 
We’ll soon see. In the near future, I don’t 
see the operating systems merging. iOS 
started as a mobile version of macOS 
and they have largely been developed 
separately, but increasingly they’re 
borrowing features from each other. 
Until the systems merge, you won’t be 
able to run an iPad app on a Mac and 
vice versa – you’ll still have to acquire 
companion versions of the same app for 
either platform. Apart from one interface 
using screen-touch and the other using 
input (trackpads, mice etc), the real barrier 
to all this is simply capacity: CPU power 
and storage.

Those barriers are being lowered almost daily.
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apple&talk > Apple wants to even further augment (and enhance) our reality

The problem with Augmented Reality is, 
simply put, processing power, but this is 
something all smart and tablet devices 
are steadily overcoming. That said, even 
ten years ago there were some genuinely 
interesting and effective examples of 
augmented reality. Indeed, it was the buzz 
back then, but what happened? Pokémon 
Go, if anything, is what put it back on the 
table.

Apple is taking it really seriously now, 
too, with the release of ARKit, which 
helps developers create augmented 
reality apps. Augmented reality places 
extra content over an overlay usually 
served by the device’s camera: hold your 
phone up, for example, over a street scene 
and see additional information overlaid, or 
a historic site as it looked in the 1880s. Or 
try new furniture in your own lounge, or 

impose fantastical storylines on existing 
scenes, or play dress-ups. Once again, apps 
like these were available ten years ago 
already. But releasing ARKit really boots 
along the whole franchise. New Zealand 
companies have long been strong in this 
realm too, for example Quiver which has 
been making strong, effective AR content 
from long before ARKit arrived.
(If you want to see if you can run ARKit on 
your device, here’s a list.)

Apple has made other interesting forays 
too, of course. Another developer kit is 
HomeKit, and we saw HomePod announced 
at WWDC. This little round speaker is easy 
to write off as ‘just another’ networked 
speaker, but we won’t really know its full 
potential until it’s released, of course. But 
what it will actually do is enable all your 
Apple devices: your iPads, iPhone, Watch 

and Mac, to be expressed 
audibly, tying them all together 
in useful ways. HomePod will 
also connect to door chimes, 
thermostats, garage doors, air 
conditioners, electrical outlets 
and more. Literally, you could 
soon be controlling everything 
you interact with via your 
iPhone in your pockets, and 
you may be able to say things 

like ‘Open front door’ to your HomePod as 
well. Perhaps most interestingly, HomePod 
will work with energy management 
technologies: imagine a future where your 
solar roof panels power all these devices 
and you interact with them via HomePod, 
including managing your Apple home 
battery (Tesla has already entered this 
field – a home battery stores the day’s solar 
energy so you can use it at night, and not 
just when the sun is shining).

So, what about Artificial Intelligence? 
A cuddly pod we can all understand: talk 
to it, and it responds, and plays music 
… Artificial Intelligence is another story. 
You know, it’s intelligent. I have always 
imagined, thanks to a steady diet of sci-fi 
growing up, that if anything with any power 
had the same or better intelligence the us, 
it would (very sensibly) want to get rid of 
us. Look at us! We’re idiots. We’re wrecking 
our home planet and voting for even worse 
idiots than us.

Am I being crazy? Facebook’s AI program 
developed its own language, and humans 
couldn’t understand it. This all went a bit 
sideways when Facebook’s scientists and 
engineers realized they couldn’t understand 
their own chatbots. So Facebook had to 
shut them down. Yikes!

NZ developers Quiver created tech that brings pages to life
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> Memories in Photos, Screenshots, camera Exif  Datatips&tricks
1/ Use Memories in the Photos app in 
macOS Sierra — Apple revamped the 
Photos App in macOS Sierra, adding a 
Memories feature, which is designed to 
help you rediscover favourite and forgotten 
moments from deep in your photo library. 
Memories automatically creates curated 
collections of your most meaningful 
photos and videos.
To use it, open the Photos app and click 
Memories in the left sidebar. You’ll see 
a summary of the Memory’s contents, 
chosen from the best photos in your library. 
Choose Show All to see every photo and 
video in the Memory.
Scroll down to see the people included in 
the Memory, a map showing where the 
photos and videos were taken, and a list 
of related Memories for you to explore. 
At the bottom of your Memory, you can 
find options to add the Memory to your 
Favorites or delete it.

2/ Save a Memory movie in macOS 
Sierra — Scroll to the bottom of the screen 
and tap or click Add to Favorite Memories. 
You’ll find it in the Favorite [sic] Memories 
album of your Photos app. If you decide 
that you don’t want to save a Memory 
anymore, tap or click Remove from Favorite 
Memories.

When you add a Memory to your 
Favorites [sic ditto], you preserve it 
and keep it from going away when 
Photos creates new Memories. You 
can also share your experiences 
with friends and family. On your 
Mac, you can share the photos and 
videos from your Memory when you 
click.
On your iPhone, iPad, or iPod touch, 
play a Memory movie, then tap on 
it to show the editing and sharing 
options. Tap  and choose to share 
the movie through Messages, Mail, 
iCloud Photo Sharing, and your 
favourite social media sites.

3/ Directly paste Screenshots into 
Documents — First, hold down 
Command ( ) + Shift + 4, to bring 
up the screenshot selection tool.
Next, hold down Control, and make your 
selection on the screen using your mouse. 
Click and drag diagonally, and when you let 
go, the screenshot is captured.
Open whatever document you want to 
paste the selection into, including email 
messages and web-page windows of sites 
you control, or Facebook, say, and press 
Command ( ) +  V or right-click/control-
click and choose Paste from the pop-out 

Contextual Menu, or select Paste from 
the Edit menu, and the screenshot you 
captured is pasted right there.

4/ View photo metadata, called Exif, 
using Preview Inspector — Preview is a 
superb and deceptively simple app built 
into macOS that has multiple uses, like 
viewing PDFs, photos and more. Preview 
Inspector (above) is one its powerful, 
hidden features that makes Preview so 
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tips&tricks > macOS Preview capabilities, and Apple Watch

useful. Short for Exchangeable image 
file format, Exif data contains important 
information about a photo. Location, 
camera model, colour space, exposure and 
more are contained in each image. If you 
need to quickly look at this information, 
using Preview is the easiest way.
Find the image you want in Finder, then 
right-click (or hold down your Control 
key and click on it) and select Open With 
Preview fro the menu that pops out.
Next, in Preview, click on Tools > Show 
Inspector in the menubar (or press  + I on 
your keyboard).
In the next window that pops up, click 
on the Exif tab. You’ll then see all of the 
pertinent information about your image.

5/ View and grab GIF frames in Preview 
— Open the GIF image in Preview – if this 
doesn’t happen when you double-click a 
GIF file, drag-and-drop the GIF onto the 
Preview icon in the Dock, or use macOS’s 
Quick Look feature to open the image 
(click the GIF’s icon ONCE, then press the 
spacebar, then click ‘Open with Preview’ in 
the upper right of the Quick Look window.
In Preview’s sidebar, scroll to the frame you 
want to save. Control- or Right-click and 
select Export As.
You can then export it in the file formats 
JPEG, PNG or PDF.

1/ Change the Playlist pictures in iOS 
Music — By default, playlists within the 
Music app use the albums’ artwork as 
their identifying image. But you can take a 
picture to use or grab one from your Photos 
library: here’s how on iPhone/iPad.
Open the Music app, and then click on the 
Library tab to visit the 
Playlists section.
Touch the one you’d like 
to change the picture 
on, and tap the Edit 
button at top right on 
the subsequent screen.
In this editing mode, 
you’ll see a small photo 
icon appear on the 
playlist’s image at top 
left – tap that.
You’ll be given an 
option to either take 
a photo or choose 
one from your library.
Choose, or take, and tap 
Done to finish the job.
The change will sync to your other devices 
if you’re using iCloud Music Library. Cool, 
right?

2/ Use your Apple Watch to auto unlock 
your Mac — Apple added a feature in 
macOS Sierra and watchOS 3 called Auto 

Unlock. This lets you automatically unlock 
your Mac by waking it up. It’s handy to use 
and easy to set up if you have an Apple 
Watch running watchOS 3 and a mid-2013 
or newer Mac running macOS Sierra 10.2 or 
newer.
First you’ll need to set up two-factor 

authentication for your Apple 
ID, as this doesn’t work with 
two-step verification. Apple has 
a support page to switch from 
verification to authentication 
(Mac Observer has an article on 
setting up 2FA here).
Once that’s set up, turn on 
Bluetooth and Wi-Fi on your 
Mac. You’ll also need to be 
signed into your Watch and Mac 
with the same Apple ID and 
your Mac can’t be using Internet 
Sharing. Check to make sure in 
System Preferences > Sharing. 
Next, go to System Preferences > 
Security & Privacy.
Both your Mac and Apple Watch 

need to be set up with a passcode. On your 
Watch, go to Settings > Passcode > Turn 
Passcode On. On your Mac, go to System 
Preferences > Users & Groups > Change 
Password.
Now on your Mac, click on the Apple icon 
(Apple Menu) in the upper left corner of 
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tips&tricks > Apple Watch, iPhone tricks with iMazing

your screen. Choose System Preferences > 
Security & Privacy > General.
Check the box next to Allow your Apple 
Watch to unlock your Mac.
It will take a couple of seconds to activate. 
Now, the next time you need to wake up 
your Mac, Apple Watch auto unlock will 
automatically unlock it. It’s just magic.

3/ Ditch the Honeycomb App Grid in 
watchOS 4 — Along with the Developer 
Beta 1 of iOS 11, Apple also recently 
released the first preview version of 
watchOS 4. This developer beta (so still 
not generally available to everyone) brings 
some under-the-hood enhancements, 
new watch faces and more intelligence 
and fitness features. It also 
includes something that 
wasn’t announced – you 
can now ditch the awkward 
honeycomb app grid and 
instead get a list of your 
installed apps:
Press the Digital Crown to get 
to your Apple Watch Home 
screen. Then, Force Touch 
the screen and a brand new 
configuration panel shows up.
Choose between grid view or 
list view.
Once you’ve made the switch, you can 

scroll normally through your apps in a list, 
sorted alphabetically. You can also rotate 
the Digital Crown to move through your 
apps, which are sorted alphabetically.
There isn’t any way to rearrange your apps 
in List View, at least for now. Bear in mind, 
though, this is still only Developer Beta 
1 of watchOS 4 so more changes may be 
yet to come in future beta versions of the 
wearable operating system. The developer 
beta is available now, and the full release is 
expected in northern autumn 2017.
(It’s also worth noting that watchOS 4 
will leave some iPhone owners out in the 
cold. It requires a paired iPhone 5S or later 
with iOS 11 to download and install. This is 
because Apple has removed 32-bit device 

support in iOS 11. Devices like the 
iPhone 4S, iPhone 5, and iPhone 5C 
are only 32-bit devices, so they aren’t 
supported by the latest version of 
the operating system.)

4/ iMazing — You know how getting 
files off an iPhone or iPad onto a Mac 
can be a mission, mostly because 
AirDrop only works sometimes? 
An app for macOS called iMazing 
changes all that. It’s not cheap 
though: a single license for iMazing 
costs US$39.99, a universal license 

is US$49.99, or you can get five licenses 

US$69.99 (for both Windows and Mac). 
all you need to do to unleash this power is 
plug your iPhone/iPad into your Mac with 
the charge cable (since it’s USB at the end 
that goes into the power charger). For 
example, via iTunes, it’s easy to transfer 
music from Mac to iPhone or iPad. What 
if you want to export tracks off your iOS 
device? That’s not possible in iTunes, 
but it’s a snap with iMazing: select the 
media files you want, whether they’re 
songs, movies, TV shows, podcasts, or 
audiobooks, then click Export to Folder, 
and iMazing will happily transfer them to 
your hard drive. It’s even smart about it, 
recognising the tracks you already have in 
iTunes and leaving them alone.

5/ Archive and even print Messages — If 
you want to save your text messages and 
iMessage conversations to your desktop, 
or even print them, with iMazing you can. 
It doesn’t matter if you want a PDF, text 
document, comma-separated values (CSV, 
like a spreadsheet) file, or a full printout of 
your messages, this app can handle it. You 
can also export attachments separately, 
for those times when you want to get a 
bunch of images out of your text message 
history.
There’s lots more about this app at Mac 
Observer.
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tips&tricks > Boolean Spotlight and other macOS tips

1/ Use Boolean Operators in Spotlight 
— All you need to do is insert the words 
AND, OR, or NOT (or a minus sign) into 
searches, depending on what you’re trying 
to find. For example, if you want to see 
files on your system with either ‘project’ 
or ‘writing’ in the title, invoke Spotlight 
by clicking on the magnifying glass in the 
upper-right corner of my screen or by 
using its keyboard shortcut (Command-
Spacebar), and type: title:project OR 
title:writing
Note there’s no space after the colon.
Alternatively, you can find items from 
two separate dates: date:6/6/66 OR 
date:17/6/17
Use NOT (or the minus sign -) to exclude 
file types, for example, from your results:
date:6/6/66 NOT kind:pdf
If you have any more questions or would 
just like to see more ways to use this, 
check out the examples Apple posted on 
this support page.

2/ Find tagged items in macOS — If 
you’ve set up your Safari-like tabs to work 
in folders in macOS Sierra, it’s easy to find 
the items you’ve tagged. Click the Finder 
icon in the Dock to open a Finder window 
and do any of the following:
Search for a tag: Enter the tag colour or 
name in the search field, then select the 

tag from the suggestions.
Ask Siri. Say something like: Find 
files with a red tag.
Select a tag in the sidebar: To see 
everything with a certain tag, click 
the tag in the Finder sidebar.
To change the items you see in 
the sidebar, choose Finder > 
Preferences, click Tags, then select the 
tags you want to see.
Arrange items by a tag: Click the Item 
Arrangement button , then choose Tags.
Sort items by a tag: In any view, choose 
View > Show View Options, then select 
the Tags checkbox. In List view and Cover 
Flow, move the pointer over the Tags 
column, then click it. Click the column 
name again to reverse the sort order.

3/ Go directly to a specific folder in 
macOS Sierra — You can jump directly to 
a specific folder in macOS Sierra: In the 
Finder, click the Go menu in the menu bar, 
then choose one of the following:
Enclosing Folder: Choose this option to 
open the parent folder for the current 
window. For example, if you’re in your 
Downloads folder, this option opens your 
All My Files, Documents, or other listed 
folders: Choose a folder from the list.
Recent Folders: Choose a folder from the 
submenu. (The submenu shows up to 10 

recently opened folders.)
Go to Folder: Type the folder’s pathname 
(for example, /Library/Fonts/ or ~/
Pictures/), then click Go.
A slash at the beginning of a pathname 
indicates that the starting point is the top 
level of your computer’s folder structure. 
A slash at the end indicates that this is a 
path to a folder, rather than a file.
A tilde (~) indicates your home folder. 
Most of your personal folders, such as 
Documents, Music, and Pictures, are in 
your home folder.
If you’re having trouble finding a folder, 
make sure you’re spelling its name 
correctly and typing the full path, 
including slashes.
You can also ask Siri to, for instance, ‘Open 
the home folder.’
(To reveal the hidden macOS Library 
folder, press and hold the Option key on 
your keyboard, then choose Library as it 
will be revealed in the Go list.)
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tips&tricks > Keychain, Safari modifications via Terminal

4/  Using Keychain’s Secure Notes 
feature — If you need to store private 
information on your Mac like an Inland 
Revenue number, there is a feature of a 
built-in program called Keychain Access 
that’ll let you store notes in a very secure 
way. If you’d like to take a look, open the 
app first—you can get to it within the 
Applications > Utilities folder by using 
Finder’s Go menu.
Once the app is open, click on “Secure 
Notes” from the sidebar and then click 
on the keychain where you’d like to store 
yours.
Use either the login or iCloud keychain for 
this – the only difference is that the iCloud 
one will sync these notes to any other 
Macs that are set up with your iCloud 
Keychain. (The notes won’t sync to your 
iOS devices, though.)
Once you’ve selected both options, click 
the plus button at the bottom-left corner 
of the window. Then you can give your new 
note a name and type the stuff you want 
to keep private under the Note field.
Once finished typing, click Add and your 
note will appear in the list. If you want 
to look at it at any point afterward, just 
go back to Keychain Access, click Secure 
Notes in the sidebar, and choose the 
keychain you added it to.
Double-click on the note to view it, and 

when you do, you won’t see the secret info 
you typed yet—yay! It’s still all hidden and 
private and stuff.
You’ll need to click the “Show Note” box 
I’ve called out above, and then your Mac 
will make you type in your login password 
to prove that you have the right to view its 
contents.
Melissa Holt likes this method better 
than using iCloud’s password-protected 
notes because it’s sort of “security by 
obscurity” – no one will likely think to look 
in Keychain Access for your notes. Which is 
good if you’re the type who doesn’t want 
anyone to even know that you have secrets 
to keep! Plus, you only have to remember 
one password – your Mac’s login one – 
which makes losing access less likely, and 
it’s darned secure as long as no one knows 
that password. For those same reasons, 
I like using Keychain Access better than 
password-protected documents, too. But 
this is certainly better than what a lot of 
people do, which is using Contacts’ Notes 
field to store very secret data. [From Mac 
Observer.]

5/ Disable autoplay in Safari — If you 
hate it when certain sites auto-play videos 
when you arrive at their site [it’s why I 
stopped using the otherwise excellent 
Macworld site], you can disable video 

autoplay using Terminal: quit Safari 
completely. 
That means clicking Safari from the top 
left of the menu bar, and then Quit. 
Once that’s done, launch Terminal from 
Applications -> Utilities. 
In Terminal, type the following commands:
defaults write com.apple.Safari 
WebKitMediaPlaybackAllowsInline 
-bool false
defaults write com.apple.
Safari com.apple.Safari.
ContentPageGroupIdentifier.
WebKit2AllowsInlineMediaPlayback 
-bool false

— If you’re running the WebKit Technology 
Preview, you’ll also need to run these 
commands in Terminal:
defaults write com.apple.
SafariTechnologyPreview 
WebKitMediaPlaybackAllowsInline 
-bool false
defaults write com.apple.
SafariTechnologyPreview 
com.apple.Safari.
ContentPageGroupIdentifier.
WebKit2AllowsInlineMediaPlayback 
-bool false

That’s it. Start up Safari once again, and 
enjoy a life free of video autoplay.
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tips&tricks > macOS tips continued –  Safari

1/ Zoom in Safari using a Magic 
Trackpad — In the Trackpad or Mouse 
system preference pane, click the Scroll 
& Zoom tab, and then you can opt to 
check or uncheck Smart Zoom. Now, 
when you double-tap with two fingers, 
Safari and other apps will zoom the item 
tapped upon to fill the screen. Two-finger 
double-tap again, and it zooms back out 
to the normal view. This zoom remains 
preserved when you go back a page and 
back forward.
Apple also offers a system-wide zoom in 
the Accessibility preference pane: open 
the pane, select Zoom, and you can opt to 
enable or disable the Use Scroll Gesture 
with Modifier Keys to Zoom. (The Control 
key is the default modifier.)

cross-site tracking. Open Safari and go 
to Preferences (press ⌘+,, or Safari > 
Preferences in the menu).
Click on the Privacy tab in the window that 
pops up.
You’ll see a new Website Tracking section 
(shown above) with two items: ‘Prevent 
cross-site tracking’ and ‘Ask websites not 
to track me’. 
The latter is also found in macOS Sierra 
and is equivalent to a Do Not Track 
setting. However, most websites won’t 
voluntarily honour this setting, and aren’t 
even legally obligated to do so.
(Apple also streamlined cookie blocking 
in Safari 11. Instead of having the usual 
settings like Always block, Allow from 
current website only, Allow from websites 
I visit, Always allow, in macOS High Sierra 
you will also just get the option to block 
all cookies, since Intelligent Tracking 
Prevention does the rest.)

3/ Use Modifier Keys with Safari history 
— You can click-and-hold on Safari’s back 
button to see a list of where you’ve been 
(above). This lets you quickly jump back 
to somewhere without hitting that back 
button several times.
There are a couple of things you can do 
with this button to make it even cooler: if 
you’re looking for URLs instead, hold down 

the Option key on your keyboard before 
you click and click-and-hold the back 
button to do just that.
If you want to keep your existing page 
as a tab or a window before you open 
something from your history, that’s easy 
too. 
Obviously, when you click the back button 
without holding it, Safari will go back to 
the last page you visited. Hold down the 
Shift key on your keyboard and click that 
button, and the browser will instead open 
your last page in a new window. If you hold 
down Command, your last page will open 
in a new tab.
This Shift-or-Command trick also works 
if you have the history view open (History 
menu>Show All History). If you click-
and-hold on your back button to bring up 
that little popover, holding down Shift 
and choosing any of the pages you visited 
opens it in a new window; Command 
opens it in a new tab. 
This behaviour is actually all through 
Safari: shift-click a bookmark or a history 
item, and it’ll open in a new window; 
Command-click a link, and it’ll open in a 

2/ Prevent tracking in Safari —  macOS 
High Sierra will have a feature called 
Intelligent Tracking Prevention, and 
Sierra already has some anti-tracking 
abilities. Safari uses machine learning to 
prevent tracking in the browser, specially 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes


>>

>
>

Mac NZ

page

17
MagBytes

#90

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

tips&tricks > AirPort WiFi, Terminal Help

new tab.
(If your version of Safari isn’t behaving in 
the way described here, be sure to check 
out your settings at Safari > Preferences 
under the Tabs section.)

4/ Changing your WiFi Password on an 
AirPort device — Sometimes you’ve may 
want to change your WiFi password – 
perhaps you gave it to someone you now 
wish you hadn’t, or maybe your roommate 
moved out, but you’ve seen them outside 
your house leeching off your connection. 
(I’m sure that’s happened to someone.) 
If you have an Apple router (like a Time 
Capsule, AirPort Extreme, AirPort 
Express), it’s really simple to change this.
Launch AirPort Utility (it’s in the 
Applications > Utilities folder, which you 
can easily get to using Finder’s Go menu.)
When AirPort Utility opens, click on your 
AirPort device and choose Edit.
You may have to enter the password for 
your device to do this; this is usually the 
same as your WiFi password, but if it’s not, 
then…uh…just keep on guessing until you 
figure it out. 
Fingers crossed. (You might consider going 
and checking your keychain to see if it’s 
stored there if you’re having trouble.)
Once you click Edit, choose the Wireless 
tab at the top. There you’ll find your 

wireless password.
So just type what you’d like your new one 
to be into both the first password box and 
the Verify Password box. Be sure that the 
‘Remember this password in my keychain’ 
choice is on, too, but don’t mess with any 
other settings there unless you know what 
you’re doing.
After your options are set, click Update. 
AirPort Utility will then of course warn you 
of what you’re about to do, and restart the 
device – full service will recommence after 
reboot.
Keep two things in mind: first, changing 
your WiFi password doesn’t change your 
base station device’s password; if you’d like 
to make that the same, head over to the 
Base Station tab within AirPort Utility.
Secondly, everything you own that 
connects to your WiFi – iPhones, iPads, 
computers, Apple TVs, and printers, for 
example – will need to be reconnected 
to your network afterward, so don’t 
undertake this task lightly as you’ll be 
typing the new password into all those 
devices. It’s no fun to spend the evening 
changing passwords on printers if you 
haven’t planned for it.

5/ Use Terminal to send the macOS Help 
Viewer to the back — You can access your 
Mac’s built-in support info by choosing 

Help from the menu at the top of any 
program. There is one irritation, though: 
the Help Viewer window always sits on 
top of everything else, even if you switch 
programs. It will stay in front until you 
close it (although you can Minimise it into 
the Dock by clicking the orange button at 
top left). 
Staying on top of everything can be 
frustrating  when you’re attempting to try 
out a solution that the help pages suggest.
Luckily, you can change this behaviour 
through Terminal (it’s in your Utilities 
folder inside the Applications folder). To 
do so, copy the following command…

defaults write com.apple.
helpviewer DevMode -bool YES

…and paste it into the Terminal program 
after the flashing prompt. When the 
command is pasted in, press Return, and 
then the Help Viewer window will behave 
just like most of the other windows on 
your Mac: if you click on another window 
or program, it’ll move to the background.
If you decide you want to put things 
back the way they were, just go back to 
Terminal, replace the ‘YES’ with ‘NO’ in the 
command, and press Return:
defaults write com.apple.
helpviewer DevMode -bool NO
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shiny&new
Norton WiFi Privacy 
A new entrant into the increasingly busy 
world of wireless and privacy is this pack 
by Norton, which promises to secure your 
wireless connection wherever you may be, 
as of course the beauty of wifi is that you 
don’t need to plug it in. 
It’s refreshing to get a pack these days, it’s 
kinda retro. In this case there’s nothing in 
it apart from some text telling you what 
to do and a long Licence Key – go to the 
indicated website, type in the key and the 
software downloads. 
Some of the VPN services out there look 
a little shoddy, and you don’t really know 
what you’re getting, but Norton is a very 
trusted security provider with a long 
history. The only downside is, VPN always 
slows connections down. Reviewed at 
Mac NZ. NZ$139.99 for 5 users (3 users 
$119.99, 1 user $89.99). 
More info: Norton. 

ZOOM UAC-2 Audio Interface 
While we’re talking about USB-C, which 
will populate itself through the Apple 
world so we should be getting our 
heads around its numerous benefits, 
unfortunately the audio interface side of 
things has only just got to USB-3 speeds. 
USB 3 is 5Gbps, USB 3.1 is 10 Gbps 
(the speed of original Thunderbolt). 
USB-C adds a 40Gbps speed to that to 
Thunderbolt 3 devices.
Still, every interface speed increase 
improves audio quality and reduces 
latency so I was keen to check this one 
out, and I needed to upgrade my interface 
anyway (I had been fond of my driver-free 
Alesis io2). ZOOM makes recorders, drum 
machines, all sorts of stuff – this records 
nice and cleanly, and it’s bus-driven but 
you’ll need a USB-USB-C adapter (it runs 
off the faster port of the Moshi symbus, 
<-left). Supports MIDI, has combo 
balanced XLR/TRS and has a Cubase 
license. NZ$459 from Rubber Monkey.

Moshi symbus compact dock
If you have a new MacBook or MacBook 
Pro, you only have USB-C ports which are 
wonderful in every single way except one: 
hardly anyone uses them. Ouch.  
To get anywhere with these marvellous 
machines, you need dongles that basically 
step down all these marvellous new 
capabilities to that boring old tech: USB, 
Ethernet, HDMI ... A Dock is one device 
using only one of those precious USB-C 
(AKA Thunderbolt 3) and parlays it into 
a veritable party of those old technology 
connectors so you can run everything you 
already have while, best of all, leaving 
three more of those USB-C ports (in the 
case of the 15-inch MacBook Pro) for 
newer technology once available.
NZ$269.99 (US$124.95): adds an HDMI 
port for external display, Gigabit Ethernet 
port, 2xUSB-A ports (one can fast-charge 
USB-C laptops up to 50W, which does not 
include the new 15-inch MacBook Pro with 
Touch Bar). Full review at Mac NZ. 

> Norton WiFi Privacy, Symbus dock, UAC-2 USB3 audio interface
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